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The Forest Service Virtual Incident Procurement (VIPR) system is a web-based 
incident procurement system. Contracting Officers (COs) use VIPR to create and 
manage solicitations and award agreements, encompassing the entire business 
process. 

Vendors (a.k.a. Contractors) will not directly access VIPR to respond to a 
solicitation. When COs post their solicitation packages to FedBizOpps (FBO), 
Vendors download the packages from FBO, and then use the VIPR Vendor 
Solution, a forms-based tool connected to the VIPR system, to respond to 
solicitations by completing the forms provided as attachments to the solicitation 
(i.e. Vendor company form and resource data entry forms) and submitting the 
completed forms as attachments to the SF 1449 when responding to the 
solicitation. VIPR will populate the SF 1449 form when an award is made. 
Vendors need only respond to the latest amendment by submitting the entire 
package (all forms) with any necessary revisions.  

All Vendors who wish to obtain a preseason incident agreement (a.k.a. Incident 
Blanket Purchase Agreement [I-BPA]) with the Forest Service MUST use the 
VIPR Vendor Solution.  

The VIPR Vendor Solution provides these key functions: 

• Automated forms for submission of Vendor offers  

• Automated confirmation that Vendor submissions are received  

• Secure, electronic signatures on awarded agreements  

1.1 User Guide Layout 

This user guide provides step-by-step instructions for using the VIPR Vendor 
Solution through the entire procurement process.  

Each section explains a specific function of the VIPR Vendor Solution:  

Section 1, “Overview” - Explains the purpose of the VIPR Vendor Solution 
and how to use this guide, provides contact information, and lists additional 
resources.  

Section 2, “Getting Started” - Lists the business and system 
requirements needed for using the VIPR Vendor Solution, as well as a 
“getting ready” checklist. 

VIPR Vendor Solution User Guide  1 
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Section 3, “Understanding How the VIPR Vendor Solution  
Works” – Describes how to use the VIPR Vendor Solution, defines what a 
“solicitation package” is, and provides suggestions on how to manage the 
solicitation packages.  

Section 4, “Locating Solicitations at FedBizOpps (FBO)” – Provides 
instructions on how to find a VIPR I-BPA solicitation in the FBO list of 
opportunities. 

Section 5, “Responding to a Solicitation” – Provides instructions on 
how to download a VIPR I-BPA solicitation package from FBO, how to 
complete the forms within a solicitation package, and how to sign and 
submit an offer. 

Section 6, “Submitting a Revised Offer” – Explains how to update 
information on an offer and re-submit the offer. 

Section 7, “Responding to an Amended Solicitation” – Provides 
instructions on how to acknowledge an amendment or respond to a 
solicitation that has been amended (a.k.a. amendment package). 

Section 8, “Working with Agreements” – Explains what happens when 
a Forest Service CO awards agreements, how to print agreements, how to 
replace equipment on an agreement, and how to withdraw equipment on an 
agreement.  

Section 9, “Responding to a Modified Agreement” – Explains the 
process for responding different types of modifications of an agreement. 

Section 10, “Printing Packages” – Provides instructions for how to print 
a package; the process is the same for all types of packages (solicitation, 
amendment, agreement, modification). 

Section 11, “Accessing the Dispatch Priority Lists” – Provides 
instructions for accessing a dispatch priority list (DPL). 

Section 12, “Appendices” – Provides supplemental information, such as a 
comprehensive list of the business rules (Appendix A), a list of key links and 
resources (Appendix B), a Vendor procurement process checklist  
(Appendix C), and a list of host dispatch centers (Appendix D).  

Section 13, “Glossary” – Lists terms and definitions used in this guide. 
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1.2 Additional Resources 

In addition to this user guide, you can use these following resources to assist 
you in understanding VIPR and the VIPR Vendor Solution.  
 

• Forest Service Incident Procurement VIPR Web site. Provides 
incident procurement information and tools to current and potential 
Vendors. 
http://www.fs.fed.us/business/incident/vipr.php 

• Frequently Asked Questions. Lists common questions and answers 
regarding all aspects of VIPR. 
http://www.fs.fed.us/business/incident/faq.php 

• VIPR Vendor Solution Tutorials (Available in mid-January 2009). 
Provides step-by-step online interactive instructions for the different 
processes used in the VIPR Vendor Solution. 
http://www.fs.fed.us/business/incident/vendorsupport.php  

• VIPR Vendor Solution Quick Reference Guide. Provides a quick 
reference to key information that is used throughout the procurement 
process when using the VIPR Vendor Solution.  
http://www.fs.fed.us/business/incident/vendorsupport.php  

1.3 Getting Help 

If you have questions about the VIPR Vendor Solution, contact the Interagency 
Incident Systems Helpdesk at helpdesk@dms.nwcg.gov or (866) 224-7677. Press 
Option 3 for VIPR / eAuth.  

The Helpdesk is open between 12:00 p.m. and 8:00 p.m. Eastern Time  
(Monday – Saturday). 

http://www.fs.fed.us/business/incident/vipr.php
http://www.fs.fed.us/business/incident/faq.php
http://www.fs.fed.us/business/incident/vendorsupport.php
http://www.fs.fed.us/business/incident/vendorsupport.php
mailto:helpdesk@dms.nwcg.gov
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To get started, you must meet specific requirements for doing business with the 
Forest Service and for using the VIPR Vendor Solution. In addition, you may 
want to gather together your company and resource information to help you get 
ready for responding to solicitations. 

2.1 Business Requirements 

To obtain an I-BPA with the Forest Service, you must meet the business 
requirements described on the Incident Procurement Web site at 
http://www.fs.fed.us/business/incident/vendors.php.  

2.2 System Requirements 

The system requirements for using the VIPR Vendor Solution are listed in the 
following table. 

You must have…  To find out if you have what you need 

Administrator rights to the 
PC you will use for the 
VIPR Vendor Solution 

If you can install software onto the PC, then you have 
administrator rights to the PC. 

Windows® NT, 2000, XP, 
or VISTA 

NOTE: The Macintosh 
version of Formatta Filler 
will NOT work with the 
forms used in the VIPR 
Vendor Solution, so you 
must use a PC with a 
Windows operating 
system. 

NOTE: The following instructions are written for Windows 
XP. The directions for other systems may vary slightly. 

1. From your desktop, right-click on My Computer and 
select Properties.  

2. Under the System heading, note the type of system 
you have. 

Free Formatta Filler® 
software 

Formatta Filler installation instructions are located at the 
Incident Procurement VIPR Web site: 
http://www.fs.fed.us/business/incident/vendorsupport.php

1 MB space available for 
downloading the Formatta 
Filler software  

NOTE: The following instructions are written for Windows 
XP. The directions for other systems may vary slightly. 

1. From the Start menu, select My Computer. 

2. Right-click on the drive where you install and use 
Formatta Filler, and then select Properties. 

3. Access the General tab. 

4. In the Free space area, note the amount of free space 

4 VIPR Vendor Solution User Guide   
 USDA Forest Service – Acquisition Management  

http://www.fs.fed.us/business/incident/vendors.php
http://www.fs.fed.us/business/incident/vendorsupport.php


  Getting Started  
 

You must have…  To find out if you have what you need 
you have available. 

Internet Explorer® 6.0 or 
better, with Java script 
enabled 

1. Open Internet Explorer. 

2. From the Help menu, select About Internet 
Explorer. 

3. Ensure you have Internet Explorer 6.0 or better. 

4. From the Tools menu, select Internet Options. 

5. Click the Advanced tab. 

6. Scroll down to the Java (Sun) heading and ensure the 
“Use JRE…” check box is selected. 

Turn off Pop-up Blocker 1. Open Internet Explorer. 

2. From the Tools menu, select Pop-up Blocker | Turn 
Off Pop-up Blocker. 

2.3 Getting Ready 

When you are responding to a solicitation, you will be asked to provide specific 
company and resource (equipment) information. You may find it helpful to 
gather the following information before you begin.  

Company Information  

 Company name 

 DUNS number 

 Contact information (first and last name, daytime phone, and e-mail 
address) for at least one company representative who will be signing 
solicitation responses 

NOTE: The company representative who will be signing 
solicitation responses MUST have a USDA eAuthentication 
Level 2 account, as described on the Incident Procurement 
VIPR Web site at 
http://www.fs.fed.us/business/incident/eauth.php. 

 Company address – street address, city, state, and zip code 

 Mailing address, if different than company address 

 Small business status  

 Supporting documentation (you will need to certify that you meet the 
requirements and provide applicable dates) 

- Required insurance, workers’ compensation (or exemption) and 
DOT inspections, as required by the solicitation 

- Workers’ compensation expiration date, if applicable 

VIPR Vendor Solution User Guide  5 
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- Sufficient number of employees and those employees meet 
the training and qualifications required by the solicitation 

- Registered in the Contractor Central Registration (CCR) system 

- Completed certifications via the Online Representations and 
Certifications Application (ORCA) 

 

Resource (Equipment) Information 

Specific information will be required for each resource. However, some common 
types of information that are required for many resources are  

 License # 

 State (where the license was issued) 

 VIN or serial number 

 Equipment ID 

 Make 

 Model 

 Year 

 Insurance policy expiration date 

 DOT inspection issue date 

 Equipment location (city, state, zip code, and dispatch center) 

 Capacity (i.e. gallons of water) 

 Daily rate 

 Contact information, if different than what is on the Vendor Company 
Information form 
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Vendor  Solution  Works  
Understanding How the VIPR
Vendor Solution Works

This section describes how Vendors will use the VIPR Vendor Solution, defines 
what a “solicitation package” is, and provides suggestions on how to manage the 
solicitation packages. 

3.1 Using the VIPR Vendor Solution 

VIPR is the application that Forest Service COs use to create and manage 
solicitations through the entire procurement process. Vendors (a.k.a. 
Contractors) will not directly access VIPR to respond to a solicitation. When COs 
post their solicitation packages to FBO, Vendors download the packages from 
FBO, and then use the VIPR Vendor Solution, a forms-based tool connected to 
the VIPR system, to respond to solicitations, acknowledge amendments, receive 
awards, and respond to agreement modifications.  

Below is a high-level diagram of how a Vendor will use the VIPR Vendor Solution 
during the procurement process. The Vendor steps are described in detail 
throughout this user guide. 

VIPR Vendor Solution User Guide  7 
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3.2 What is a Solicitation Package? 

A solicitation packages consists of the official government forms, contract 
requirements, and Vendor resource forms required for a competitive solicitation. 
Depending on where you are in the procurement process, you may be working 
with one of the following types of packages:  

• Solicitation package – used for new solicitations and posted to FBO 

• Amendment package – used for solicitations that have been amended 
and posted to FBO 

• Agreement package – sent to Vendors who have received an award on 
the solicitation 

• Modified agreement package – used for agreements that are modified 
and sent to Vendors who received the original agreement package  

COs ensure each package contains the required forms specific to that 
solicitation. Vendors responding to a solicitation, amendment, agreement, or 

8 VIPR Vendor Solution User Guide   
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modified agreement use the VIPR Vendor Solution to complete and subm
required forms within the specific package.  

it the 

lowing table provid cription of each o
s within a packa m. 

The fol es a brief des f the forms and 
document ge and how you will use the

Form Description Actions By Vendor 

SF 1449  
t/ 

rder for Commercial Use) 

es:  
 will be auto-

populated by VIPR based 
on Award information. 

(Solicitation/Contrac
O

In all four types of packag
Official form used for the 
solicitation and award of 
competitive solicitations  

View only. Do NOT fill in
this form; it

Schedule of Items  
 
The information on this 
form varies slightly 
depending on whether this 
form is part of a 
solicitation/amendmen

In solicitation and amendment 
packages: List of all of the 
resources included in a specific 
solicitation. 

In agreement and modified 

View only. 

agreement packages: List of all 
t 

package or an 
of the resources that the CO has 
awarded on the agreement. 

agreement/modified 
agreement package.  

Table of Contents es: View only. In all four types of packag
Official form used for the 
solicitation and award of 
competitive solicitations  

SF 30  
(Amendment of 
Solicitation/ Modification  
of Contract) 

In amendment and modified 
agreement pa

View only. 
ckages: Official 

form used for amending 
solicitations and modifying 
agreements. 

Contract Requirements and pes of packages: View only. 
Exhibits  

In all four ty
Contract requirements and 
exhibits specific to the 
solicitation. 

Representations-
Certifications-  
FAR 52.212-3 (a.k.

In solicitation packages and in 
some cases, amendment 
packages: Official document 
required with your offer. 

Complete the editable 
areas within the document 
that apply to your a. 

Section E) company. 

Vendor Company In all four types of packages:  
Vendor-specific form used to 
capture company identification

Complete this form and 
Information Form include in every response. 

, 
contact information, company 
address, small business status, 
discount terms, and company 
insurance and special 
certification requirements. 

Resource Data Entry Form In all four types of packages: 
Data entry forms for each 
resource that is needed for the

Complete the resource 
data entry forms specific to 

 
solicitation; used to capture

your company resources 
 

equipment 
and include in every 

description, location, response. 
attributes, rates, and contact 
information specific to the 
resource.  
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3.3 Managing the Package Files  

Each package consists of forms and other types of documents (e.g., contract 
requirements and exhibits) that are attached to the SF 1449. Because of the 
different states of a package throughout the procurement process, you may 
need to manage multiple versions of a package (e.g., the original solicitation, 
amendment 1, amendment 2, modification 1, etc.).  

When you respond to a solicitation, amended solicitation, agreement, or 
modification to an agreement, you will need to submit a complete package with 
all of the appropriate forms and documents included in the package. Therefore, 
it is important that you keep track of your different packages.  

In this user guide, Section 5.1, “Downloading a Solicitation Package from FBO” 
provides suggestions on how to keep track of the different packages and their 
forms by setting up a folder structure that has one main “Solicitations” folder 
with “solicitation number” subfolders (e.g., AG-1234-S-09-7011 folder). You can 
keep your company form and the resource forms you will use for multiple 
solicitations in the Solicitations main folder. In a solicitation number subfolder, 
you can keep the different versions of the solicitation package along with any 
resource forms that will be specific only to that particular solicitation package. 

Below are examples of how the recommended folder structure might look. 
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Example of a Solicitations Folder  

 

 

Example of a Solicitation Number Subfolder 
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FedBizOpps  (FBO)  
Locating Solicitations at
FedBizOpps (FBO)

This section provides instructions for locating a solicitation package that has 
been posted to FBO through VIPR.  

For detailed instructions on how to use the many features of the FBO Web site, 
access the FBO Vendor Guide at 
https://www.fbo.gov/downloads/FBO_Vendor_Guide.pdf.  

To search for a solicitation posted by VIPR: 

1 Access the FBO Web site at http://www.fbo.gov/ and in the center of the 
page under Find Opportunities, click on Advanced Search.  

 

2 From the Opportunities screen, in the Keywords/SOL# field, type the 
solicitation number or type “VIPR I-BPA.”   

 

https://www.fbo.gov/downloads/FBO_Vendor_Guide.pdf
http://www.fbo.gov/
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3 In the Posted Date field, select the appropriate date range, and then click 
the Go button. A list of all of the solicitations that match your search criteria 
appears. 

  

4 Click on the link from the search results to view the Notice Details for the 
solicitation. 

 

 

IMPORTANT 

The Forest Service solicitation packages (.pff files) can only be viewed, 
completed, and submitted using the free Formatta Filler software; other 
applications that are used to view and fill in forms (i.e. Adobe Reader) will 
NOT work with the VIPR Vendor Solution. For instructions on how to install 
Formatta Filler, go to the Incident Procurement VIPR Web site at 
http://www.fs.fed.us/business/incident/vendorsupport.php.  

Once you find the VIPR solicitation you want to respond to, follow the 
procedures in Section 5, “Responding to a Solicitation.” 

 

 

http://www.fs.fed.us/business/incident/vendorsupport.php
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To respond to a solicitation, you will need to  

• Download the solicitation package or amendment package from the FBO 
Web site to your local drive or a thumb drive 

• Complete the forms within the solicitation package or  
amendment package 

• Sign and submit your offer 

NOTE: You can perform all of these procedures during the same working 
session or in stages as long as you save your work. If you are completing the 
solicitation package in stages and it has been a while since you first downloaded 
the solicitation package, you may want to check FBO to see if amendments have 
been posted to that solicitation.  

For instructions on how to find a solicitation, refer to Section 4, “Locating 
Solicitations in FedBizOpps (FBO).” 

5.1 Downloading a Solicitation Package from 
FedBizOpps (FBO) 

This section describes how to download a solicitation (or amendment) package 
from the FBO Web site and save the package to your local hard drive.  

NOTE:  The steps described below are the same whether you are downloading a 
solicitation package or an amendment package. If the solicitation has 
amendments, then you will only need to respond to the latest amendment 
package for that solicitation—you will not need to respond to both the solicitation 
package and the amendment package for that solicitation. 

 IMPORTANT 

You can download a solicitation package at any time from FBO; HOWEVER, 
you must have the free Formatta Filler software installed on your computer 
to be able to view and complete the forms within the package. Other 
applications that are used to view and fill in forms (i.e. Adobe Reader) will 
NOT work with the VIPR Vendor Solution. For instructions on how to install 
Formatta Filler, go to the Incident Procurement VIPR Web site at 
http://www.fs.fed.us/business/incident/vendorsupport.php.   

http://www.fs.fed.us/business/incident/vendorsupport.php
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To download a solicitation package: 

1 Access the FBO Web site at http://www.fbo.gov/. 

2 From the Opportunity List, find the solicitation you wish to respond to, and 
then click on the solicitation link within the list.  

 

The solicitation details screen appears. 

 

3 From the ALL FILES section on the right side of the screen, click on the http 
link for the solicitation package. A File Download dialog box appears. 

 

VIPR Vendor Solution User Guide  15 
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 IMPORTANT  

You will need to respond to the latest version of the package, which is 
always in the ALL FILES list. If the solicitation has amendments, then 
you will only need to respond to the latest amendment package for that 
solicitation—you will not need to respond to both the solicitation package 
and the amendment package for that solicitation. If you have responded 
to a solicitation and it has been amended since you first responded, then 
VIPR will notify you of the amendment and you will need to follow the 
instructions in Section 7, “Responding to an Amended Solicitation.”  

 

4 Click the Save button. A Save As dialog box appears. 
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5 In the Save in: field, open the My Documents | My Forms folder.  

IMPORTANT  

You can save the solicitation package using any folder structure you 
prefer; however, to assist you with managing multiple solicitation 
packages, it is recommended you use the folder structure described in 
the steps below. 

6 From the My Forms folder, create the “Solicitations” folder by doing the 
following: 

NOTE:  If you have already created the Solicitations folder, 
then open the Solicitations folder and go to Step 7. 

a. At the top of the Save As dialog box, click on the Create New 

Folder  icon. A new folder appears with the default name, 
New Folder, highlighted.  

VIPR Vendor Solution User Guide  17 
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b. Ensure the New Folder is highlighted, type Solicitations as the 
name for the new folder, and then press Enter.  

c. Double-click on the Solicitations folder to open it, and then go 
to Step 7.  

7 From the Solicitations folder, create a folder for the solicitation number by 
doing the following: 

NOTE:  If you have downloaded a solicitation or 
amendment package for this specific solicitation number 
before, then you would have already created a folder for 
this solicitation number. If that is the case, then open the 
<solicitation number> folder and go to Step 8. 

a. From the Solicitations folder, in the File name field, select the 
solicitation number, and then press Ctrl + C to copy the solicitation 
number.  
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b. At the top of the Save As dialog box, click the Create New Folder 

 icon. A new folder appears with the default name, New Folder, 
highlighted. 

c. Ensure the New Folder is highlighted, press Ctrl + V to paste the 
solicitation number as the new folder name, and then press Enter. 

d. Double-click on the solicitation number folder to open it, and then 
proceed to Step 8.  

8 Click the Save button. The <solicitation number>.pff is saved in the My 
Documents | My Forms | Solicitations | <solicitation number> 
folder on your local hard drive. 

9 From the Download complete dialog box, click the Open Folder button.  

VIPR Vendor Solution User Guide  19 
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The solicitation number folder opens with the <solicitation number>.pff file 
highlighted. 

 

The remaining steps explain how to copy the solicitation package so you have an 
“original” version and working version of the solicitation package. 

10 Press Ctrl + C to copy the <solicitation number>.pff. 

11 Click off of the highlighted file and press Ctrl + V to paste a copy of the 
<solicitation number>.pff file in the same folder. 

 

12 Right click on the copied file and select Rename. 
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13 Type Original- before the solicitation number, and then press Enter. This 
saves an original version of the solicitation package should you ever need to 
refer to it. For example, if you inadvertently deleted a form from your 
working version of the solicitation, then you can retrieve a blank form from 
the original version of the solicitation and would not need to download the 
solicitation package again.   

 

The download is complete. You have an original version of the solicitation and a 
working version of the solicitation saved to your local hard drive (or a thumb 
drive).  

 

What’s next? You can change the default folder location for Formatta to be 
your “Solicitations” folder (see the side note below), or you can go directly to 
Section 5.2, “Completing the Solicitation Package.” 

 

VIPR Vendor Solution User Guide  21 
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5.2 Completing the Solicitation Package 

Once you have downloaded the solicitation package (or amendment package) 
from FBO, you will need to view the contract requirements and exhibits; 
complete the Representations/Certifications (FAR 52.212-3); complete the 
Vendor Company Information form; and complete the appropriate Resource Data 
Entry forms for every resource you wish to include with your offer.  

This section provides instructions for the following: 

• Viewing the contract requirements and exhibits for a solicitation 

• Completing the Representations-Certifications -FAR 52.212-3 for a 
solicitation 

• Completing Vendor Company Information form, which includes  
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- Adding the completed company form to the solicitation package 

- Deleting the blank Vendor Company Information form from the 
solicitation package 

• Completing resource data entry forms for your resources, which includes  

- Selecting the appropriate Dispatch Centers for your resources 

- Adding completed resource data entry forms for each piece of 
equipment to the solicitation package  

- Deleting blank resource data entry forms from the solicitation 
package 

5.2.1 Viewing the Contract Requirements and Exhibits for a 
Solicitation 

Before you start completing the forms within a solicitation package, you should 
first review the contract requirements and exhibits for that specific solicitation. 
The contract requirements and exhibits are included as “attachments” to the  
SF 1449 form, which is visible when the solicitation package is first opened.  

To view the contract requirements and exhibits for a solicitation: 

1 From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

NOTE:  You would have set up the Solicitations and solicitation number folder 
when you downloaded the solicitation or amendment package (Section 5.1, 
“Downloading the Solicitation Package from FedBizOpps (FBO)”).  

 

2 Double-click on the <solicitation number>.pff file or the <solicitation 
number_Amendment #>.pff file. The SF 1449 form for that solicitation 
opens. 
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3 From the Form menu, select Attachments. (You can also click on the paper 
clip icon to access the Attachments.)  

 

A list of Attachments appears. 
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4 From the list of Attachments, double-click on the 
ContractRequirements.pdf file, which will vary depending on the type of 
solicitation. 

 

NOTE: If a message appears warning you that attachment may contain viruses, 
you can ignore it because the attachment is a valid document. Click Yes to open 
the attachment. 

 

Below is an excerpt from an example of a contract requirements document for  
a solicitation.  
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5 Review the solicitation to ensure that you understand and can comply with 
the contract requirements, and then close the document.  

6 From the list of Attachments, double-click on an Exhibits document, which 
will vary depending on the type of solicitation.  
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NOTE: If a message appears warning you that attachment may contain viruses, 
you can ignore it because the attachment is a valid document. Click Yes to open 
the attachment. 

Below is an excerpt from a sample Exhibits document for a solicitation. 
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7 Review the Exhibits document to ensure that you understand and can 
comply with the requirements, and then close the document.  

8 Repeat Steps 6-7 for each Exhibits document within the package. 
 

What’s next? You must complete the Representations-Certifications -FAR 
52.212-3, so proceed to Section 5.2.2, “Completing the Representations-
Certifications -FAR 52.212-3.” 

 

5.2.2 Completing the Representations-Certifications -FAR 
52.212-3 

You are required to complete FAR 52.212-3, Offeror Representations and 
Certifications – Commercial Items (Section E-3) with your offer. To complete this 
submission, you can do any of the following: 

• Use the Online Representations and Certifications Application (ORCA) at 
http://orca.bpn.gov to electronically complete the annual representations 
and certifications in accordance with FAR 52.212-3. 

NOTE:  If you use ORCA, you are not required to submit your 
representations and certifications with your offer. 

• Download the FAR 52.212-3 clause from 
http://www.acquisition.gov/comp/far/index.html, complete and save the 
document and then print and mail the hardcopy document to the Issued 
By office, which is in Box 9 on the SF 1449 form. 

NOTE: If you submit a hardcopy of your representations and 
certifications, the CO must receive the documentation by the 
solicitation close date and time. 

• Download the FAR 52.212-3 clause from the solicitation package, 
complete and save the document, and then attach the document to your 
offer. (Instructions are described below.)  

IMPORTANT 

Unless you have completed the information electronically using ORCA, you MUST 
submit this information for each solicitation you respond to. However, you will 
only need to provide the representations and certifications once for a solicitation 
unless that specific information has been modified, which will be specified on the 
SF 30 form of an amendment package. If you respond to different packages for 
a specific solicitation (amendment package, agreement package, and 
modification package), you do not need to re-submit your representations and 
certifications again for those packages.    

http://orca.bpn.gov/
http://www.acquisition.gov/comp/far/index.html
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To access the Representations-Certifications -FAR 52.212-3 document 
within a solicitation package, do the following: 

1 From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

 

2 Double-click on the <solicitation number>.pff file. The SF 1449 form 
opens. 

 

3 From the Form menu, select Attachments. (You can also click on the paper 
clip icon to access the Attachments.)   
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A list of Attachments appears. 

 

4 From the list of Attachments, double-click on the Representations-
Certifications -FAR 52.212-3.doc file.  
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NOTE: If a message appears warning you that attachment may contain viruses, 
you can ignore it because the attachment is a valid document. Click Yes to open 
the attachment. 

 

5 Within the document, from the File menu, select Save As.  
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NOTE: The first time you save a document that you opened through the 
Attachments list, you must do a File | Save As to save the document to the 
Solicitations folder. Otherwise, your document will be saved to C:\Documents 
and Settings\<your username>\Local Settings\Temp. 

The Save As dialog box appears. 

 

6 In the Save in: field, open the Solicitations | <solicitation number> 
folder, and then click the Save button to save the Representations-
Certifications -FAR 52.212-3 document.  
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7 In the Representations-Certifications -FAR 52.212-3 document, complete all 
of the editable areas that are specific to your solicitation response. 

NOTE:  Editable areas within this document are indicated by 
highlighted brackets. All other information within this document is 
non-editable.  

 

8 Save your changes, and then close the document. 

9 From the Attachments list, select the original Representations-
Certifications -FAR 52.212-3.doc file, and then click the Delete button. 

 

The original Representations-Certifications -FAR 52.212-3 document is 
removed from the solicitation package.  

10 From the Attachments list, click the Add button. 
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11 From the Open dialog box, in the Look in: field, open the Solicitations | 
<solicitation number> folder, select your completed Representations-
Certifications -FAR 52.212-3.doc, and then click the Open button.  

 

Your completed Representations-Certifications -FAR 52.212-3 document attaches 
to the solicitation package.  
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What’s next? You are ready to complete the forms within the solicitation 
package, so proceed keep the Attachments list open and follow the steps in  
Section 5.2.3, “Completing the Vendor Company Information,” (start at Step 4). 

5.2.3 Completing the Vendor Company Information 

You only need to fill out the Vendor Company Information form once and then 
you can use the completed company form for all of your solicitation responses. 
You can make updates to this form at any time. 

Business Rule: You MUST attach a completed Vendor Company Information 
form to EVERY offer you submit. 

1 From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

NOTE:  You would have set up the Solicitations and solicitation 
number folder when you downloaded the solicitation or 
amendment package (Section 5.1, “Downloading the 
Solicitation Package from FedBizOpps (FBO)”).  
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2 Double-click on the <solicitation number>.pff file or the <solicitation 
number_Amendment #>.pff file. The SF 1449 form for that solicitation 
opens. 

3 From the Form menu, select Attachments. (You can also click on the paper 
clip icon to access the Attachments.) 

 

A list of Attachments appears. 

 

4 Depending on your situation, do one of the following: 

• If you have submitted responses to previous solicitations and already 
have a completed Vendor Company Information form, then proceed to 
Step 5. 

• If this is the first time you have responded to a solicitation, then do the 
following: 
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a. From the Attachments list, double-click on the 
VendorCompany.pff file.  

IMPORTANT 

When you double-click on a form from within the Attachments 
list, the work you do in that form will NOT automatically replace 
the blank form that is currently attached to the SF 1449 form. 
The process required to replace the blank attachment with your 
completed form is described later in the steps below.  

 

The Vendor Company Information Form appears. 

 

b. From the File menu, select Save As.  
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NOTE:  The first time you save a form that you opened through 
the Attachments list, you must do a File | Save As or click the 
Save button at the bottom of the form to save the form to the 
Solicitations folder. After the initial save, then you can use the 
Save icon from the toolbar. 
 

 

The Save As dialog box appears. 

tip  
If you click on the 
Save icon on the 
toolbar before doing 
a Save As action, 
then your form will 
be saved to 
C:\Documents and 
Settings\<your 
username>\Local 
Settings\Temp and 
not the Solicitations 
folder you set up. 
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tip  
If you will use your 
completed company 
information form for 
all of your 
solicitation 
responses, then you 
should save the 
form in one central 
location—the 
Solicitations folder—
rather than in one 
specific solicitation 
number folder. 

c. From the Save in: field, find the Solicitations folder.  

d. In the File name: field, highlight “VendorCompany[#],” type your 
company name, and then click the Save button.  

 

e. Complete the form.  

IMPORTANT 

You MUST complete all of the required fields, which are 
indicated by an asterisk and yellow background on the form.  

Also, the company name you use in the form MUST match the 
company name you use in CCR. 

f. Once you have entered all of your data, click the Validate Form 
button (located at the bottom of the form) to ensure you have 
completed all of the required fields and entered data correctly. 

g. If you receive a validation error, please refer to the validation 
message and check the following: 

 All of the required fields have data entries. 
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 The appropriate type of information is provided in the fields, 
e.g., the first Zip Code box has five (5) digits. 

 In some cases, if one field in a group of fields has a data 
entry, then the other fields in the group become required. For 
example, for the Contact Information, if a First Name is 
entered, then the Last Name, Daytime Phone, and E-mail 
Address fields are then required.  

If you have questions about the validation errors, contact the 
Interagency Incident Systems Helpdesk at helpdesk@dms.nwcg.gov 
or (866) 224-7677 (press Option 3 for VIPR). 

h. Once your changes are complete, click the Save button (located at 
the top in the Form toolbar and at the bottom of the form). Your 
completed company form is saved in the Solicitations folder. 

i. Click the Close button  in the upper right corner of the 
Vendor Company Information form. The company form closes and 
the Attachments list appears. Proceed to Step 5. 

 
In the following steps, you will ensure the version of your completed 
company form is current, add your completed company form to the SF 
1449 form, and delete the blank Vendor Company Information form 
that is still attached to the SF 1449 form.  

5 From the Attachments list, double-click on the VendorCompany.pff form 
within the solicitation (or amendment package). 

6 Scroll to the bottom of the form and check the Version # on the form.  

 

7 Depending on the version of the form, do one of the following: 

mailto:helpdesk@dms.nwcg.gov
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• If the Version # on the form matches the Version # of the form that 
you had previously completed for other solicitations, then close the 
form, and proceed to Step 8.  

• If the Version # on the form is a newer version than the form you 
had previously completed, go back to Step 4b, perform Steps 4b-4i 
to complete and save the newer version of the company form, and 
then proceed to Step 8.  

8 From the Attachments list, click the Add button. 

 

The Open dialog box appears. 

 

9 From the Solicitations folder, select your completed <companyname>.pff 
form, and then click the Open button. Your completed company form 
attaches to the solicitation package and you can see your company form is 
now in the list of Attachments.  
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10 From the Attachments list, select the VendorCompany.pff file, and then 
click the Delete button.  

 

The original blank Vendor company form is removed from the solicitation 
package.  
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What’s next? Depending on where you are in the process for responding to a 
solicitation process, do the following: 

• If you have not yet completed the resource data entry forms for the 
package, then keep the Attachments list open and follow the steps 
in Section 5.2.4, “Completing the Resource (Equipment) 
Information,” (begin at Step 4). 

• If your solicitation package has all of the completed forms required 
for your offer, i.e. your completed company form AND a completed 
resource data entry form for each piece of equipment, then from the 
Attachments list, click the Close button, and then from the SF 1449 
form, click the Save button to save your solicitation package. You 
are now ready to proceed to Section 5.3, “Signing and Submitting an 
Offer.” 

5.2.4 Completing the Resource (Equipment) Information  

NOTE:  Each type of equipment has its own unique resource data entry 
information form. However, for the purpose of this documentation, the Dozer 
Type 1 resource data entry form will be used as the example form in the 
following steps. 

Unless you have updates to your resource information, you will only need to fill 
out the resource data entry forms once for each resource. You can then use 
your completed forms (when applicable) for all solicitation responses.  

Business Rule: You MUST always attach at least one completed resource data 
entry form for each piece of equipment to EVERY offer you submit. 
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1 From Windows Explorer, open the Solicitations | <solicitation 
number> folder. 

NOTE:  You would have set up the Solicitations and solicitation number folder 
when you downloaded the solicitation or amendment package (Section 5.1, 
“Downloading the Solicitation Package from FedBizOpps (FBO)”).  

2 Double-click on the <solicitation number>.pff or if the solicitation has an 
amendment, then double-click on the <solicitation number_Amendment 
#>file. The SF 1449 form for that solicitation opens. 

3 From the Form menu, select Attachments. (You can also click on the paper 
clip icon to access the Attachments.) 

 

A list of Attachments appears. 
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IMPORTANT 

The Attachments list contains a resource data entry form for each type of 
resource (equipment) included in the solicitation; however, you only need to 
complete the resource data entry forms for the type of equipment that you 
wish to include with your offer. 

4 Depending on your situation, do one of the following: 

• If you have gone through this response process before and have already 
completed your resource data entry forms, proceed to Step 5. 

• If you are going through this response process for the first time, then do 
the following: 

a. From the Attachments list, double-click on a <resource data entry 
form>.pff file.  

IMPORTANT 

When you double-click on a form from within the Attachments 
list, the work you do in that form will NOT automatically replace 
the blank form that is currently attached to the SF 1449 form. 
The process required to replace the blank attachment with your 
completed form is described later in the steps below.  

 

The specific resource data entry form appears. In this example, the  
Dozer, Type 1 form appears. 
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b. From the File menu, select Save As.  

 

NOTE:  The first time you save a form that you opened through 
the Attachments list, you must do a File | Save As or click the 
Save button at the bottom of the form to save the form to the 
Solicitations folder. After the initial save, then you can use the 
Save icon from the Form toolbar. 

tip  
If you click on the 
Save icon on the 
toolbar before doing 
a Save As action, 
then your form will 
be saved to 
C:\Documents and 
Settings\<your 
username>\Local 
Settings\Temp and 
not the Solicitations 
folder you set up. 
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The Save As dialog box appears. 

c. From the Save in: field, find the Solicitations folder if it is not already 
selected.  

d. In the File name: field, highlight the <resource name [#]>, type 
the name of your resource, and then click the Save button.  

 

The resource data entry form is saved in the Solicitations folder. 

tip  
When changing the 
name of the file for 
your resource, you 
may want to use a 
name specific to the 
piece of equipment, 
e.g., VIN number, 
Equipment ID, etc. 

e. Complete the form.  

IMPORTANT 

You must complete all of the required fields, which are indicated 
by an asterisk and yellow background on the form.  
 
When selecting a dispatch center, refer to Appendix D, 
“List of Host Dispatch Centers.” For additional 
information about dispatch centers, visit the Incident 
Procurement Web site at 
http://www.fs.fed.us/business/incident/vipr.php.  

f. Once you have entered all of your data, click the Validate Form 
button (located at the bottom of the form) to ensure you have 
completed all of the required fields and entered data correctly. 
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g. If you receive a validation error, please refer to the validation 
message and check the following: 

• All of the required fields have data entries. 

• The appropriate type of information is provided in the fields, 
e.g., the first Zip Code box has five (5) digits. 

• In some cases, if one field in a group of fields has a data entry, 
then the other fields in the group become required. For example, 
for the Contact Information, if a First Name is entered, then the 
Last Name, Daytime Phone, and E-mail Address fields are then 
required.  

If you have questions about the validation errors, contact the 
Interagency Incident Systems Helpdesk at helpdesk@dms.nwcg.gov 
or (866) 224-7677 (press Option 3 for VIPR). 

h. Once your changes are complete, click the Save button (located at 
the top in the Form toolbar and at the bottom of the form). Your 
completed resource data entry form is saved in the Solicitations 
folder. 

i. Repeat Steps 4a – 4h for every resource that you wish to include in 
your solicitation response.  

IMPORTANT 

You must complete a resource data entry form for every 
resource that will be in your solicitation response. For example, 
if your response will include two Dozer Type 1s, then you will 
need to complete two Dozer Type 1 forms; you CANNOT use 
one form for both Dozers. You can copy one completed Dozer 
form, rename the file, and then complete the information 
specific to the other Dozer. 

j. Click the Close button  in the upper right corner of the 
form. The resource data entry form closes and the Attachments list 
appears. Proceed to Step 5. 

In the following steps, you will ensure the version of your resource 
data entry form is current, add your completed resource data entry 
form(s) to the SF 1449 form and then delete the blank resource data 
entry forms that are still attached to the SF 1449 form.  

5 From the Attachments list, double-click on the <resource data entry 
form>.pff form. 

6 Scroll to the bottom of the form and check the Version # on the form. 

mailto:helpdesk@dms.nwcg.gov
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7 Depending on the version of the form, do one of the following: 

• If the Version # on the form matches the Version # of the form that 
you had previously completed for other solicitations, then close the 
form, and proceed to Step 8.  

• If the Version # on the form is a newer Version than the form you 
had previously completed, go back to Step 4b, perform  
Steps 4b - 4i to complete and save the newer version of the 
resource data entry form, and then proceed to Step 8.   

8 From the Attachments list, click the Add button.  

 

The Open file dialog box appears. 

9 From the Solicitations folder, select your completed resource data entry 
form, and then click the Open button.  
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Your completed resource form is now attached to the solicitation package. 

 

10 From the Attachments list, select the <resource data entry form>.pff 
file, and then click the Delete button. The original blank resource form is 
deleted from the package.  
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11 Repeat Steps 5-10 for all resource data entry forms that will be included in 
your solicitation response and to delete ALL of the blank resource data entry 
forms.  

IMPORTANT 

• If a solicitation requires additional information to be submitted with the 
offer, i.e. resumes, certifications, etc., use the Add button in the 
Attachments list to add those documents to the solicitation package. 

• Be sure to delete ALL of the blank forms from the package, including the 
resource data entry forms that you do not use, otherwise, when you 
submit your offer, you will get an error because there are blank forms in 
your solicitation package.  

Business Rule: You MUST attach one completed resource data entry form for 
every resource that will be in your solicitation response. For example, if your 
response will include two Dozer Type 1s, then you will need to attach two Dozer 
Type 1 forms; you CANNOT attach one form for both Dozers. Another example is 
the Transport resource, where you must have one form for each Transport type. 

 

What’s next? Based on where you are in the process for responding to the 
solicitation, do one of the following: 

• If you have not completed the Vendor Company Information form 
for the solicitation or amendment package, then keep the 
Attachments list open and follow the steps in Section 5.2.3, 
“Completing the Vendor Company Information,” (begin with Step 4). 

• If your solicitation or amendment package has all of the completed 
forms required for your offer, i.e. your completed company form 
AND your completed resource data entry forms, then from the 
Attachments list, click the Close button, and then from the SF 1449 
form, click the Save button to save your solicitation package. You 
are now ready to follow the steps in Section 5.3, “Signing and 
Submitting an Offer,” (begin with Step 3). 

5.3 Signing and Submitting an Offer 

When you submit an offer, your solicitation response package must be complete, 
which means it must  

• Include all of the standard forms that were part of the original package, 
i.e. SF 1449 form, Contract Requirements and Exhibits, Representations-
Certifications -FAR 52.212-3, and SF 30 (when applicable) 

• Include your completed company information form 
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• Include your completed resource data entry forms for all of the 
resources you wish to include in your offer 

• Exclude any blank Vendor company information or resource data entry 
forms 

 IMPORTANT 

When you are ready to submit an offer, you will be legally signing your offer 
and will be required to provide your eAuthentication username and 
password.  

Business Rules:  
You can continue to update your company and resource information and re-
submit an offer (solicitation package) until the solicitation close date. After the 
close date, VIPR will not accept a response unless the CO has notified you of a 
problem and allows you to re-submit your response or has entered into 
negotiations and requested a revised offer. 

VIPR will use the Vendor’s last response as the response on record; VIPR will 
NOT try to determine the difference between multiple packages for the same 
solicitation sent by the same Vendor. 

 

To sign and submit an offer for a solicitation: 

1 From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

2 Double-click on the <solicitation number>.pff file or if the solicitation has 
an amendment, then double-click on the <solicitation 
number_Amendment #>file. The SF 1449 form opens. 

3 At the bottom of the SF 1449 form, click the Sign Response button.  

 

A message appears explaining what it means when you use your 
eAuthentication UserID and password to sign a response. 
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4 Click Yes to proceed.  

IMPORTANT  

Once you complete the steps for the eAuthentication process for a 
specific solicitation (described in Steps 5-11 below), you might not be 
required to perform those steps again the next time you click the “Sign 
Response” button on the SF 1449 form for that solicitation. When this 
occurs, it means your eAuthentication login information is already in the 
system for that solicitation and you can jump from Step 4 to Step 12.       

5 If an authorization message appears, click the Continue button once. Wait 
a few seconds for this window to be replaced with the eAuthentication Web 
site warning message. 
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NOTE: You may need to drag the window edges to re-size the window in order 
to view the entire message. 

6 From the eAuthentication Warning message box, click the Continue button. 
The eAuthentication Login screen appears. 

NOTE: You may need to drag the window edges to re-size the window in order 
to view the entire message. 

 

7 Enter your eAuthentication username and password, and then click the 
Login button.  
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NOTE: If you do not remember your eAuthentication username or 
password, contact the ITS Service Desk at 
mailto:eAuthHelpDesk@ftc.usda.gov or 800-457-3642. 

A Security Alert message appears. You can ignore this message because the 
VIPR site is secure. 

 

8 Click Yes to continue. A message informing you that you are authorized to 
submit your response appears. 

 

9 Click on the Close button to close the message window. The SF 1449 form 
re-appears. 

 

10 From the SF 1449 form, click the Sign Response button again.  

The message explaining what it means when you use your eAuthentication 
UserID and password to sign a response re-appears. 
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11 Click Yes to proceed.  

12 VIPR conducts a validation test to check for the following: 

• For every solicitation response, your company information form 
and at least one resource data entry form specific to the 
solicitation are attached to the SF 1449 form. However, VIPR 
cannot ensure that all resource data entry forms specific to your 
equipment are attached. 

• Each resource data entry form has a unique Vendor-provided 
identifier (e.g., VIN number, Equipment ID, etc.). The same 
identifier cannot be used for the same resource type for the 
same solicitation.  

• The forms attached to the solicitation response are the correct 
version of the forms. If the forms are the incorrect version due 
to a change in the form or an amendment, VIPR will notify you 
and you will need to download the latest version of the 
solicitation package from FBO, complete the solicitation package 
with the new version of the forms, and re-submit your offer.  

You will receive either a successful submittal message or an error 
message. Details about each type of message are explained below in the 
“Types of Submittal Validation Messages.” 

Types of Submittal Validation Messages 

Based on the results of the validation check, you will get one of the following 
messages: 

(1) Successful submittal: 

 
If you get this message, you can close this window. Your offer has been 
received in the VIPR system. If there are amendments to this 
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solicitation, then VIPR will notify you. Otherwise, you will not be notified 
about the status of your offer for this solicitation until after the 
solicitation close date. 

NOTE: When your response is successfully submitted, you 
have met the requirement described in Box 28 of the SF 1449 
form which is to provide a signature and a copy of the form. 

(2) Your completed Vendor Information form was not attached 
to the solicitation: 

 
If you get this message, you can close this window. Access the 
Attachments list and ensure you have attached your completed company 
form to the solicitation package AND deleted the blank Vendor Company 
Information form. 

(3) Your completed resource data entry form was not attached 
to the solicitation: 

 
If you get this message, you can close this window. Access the 
Attachments list and ensure you have attached your completed resource 
data entry forms that are specific to the solicitation AND deleted all 
blank resource data entry forms from the solicitation package. 

(4) You have an incomplete form within the package.  

 

If you get this message, you can close this window. Required fields on 
either the Vendor Company form and/or a resource data entry form may 
be incomplete OR blank forms have not been deleted from the package. 
This message is just one example for an attached data entry form 
(Mobile Laundry Type 1) that has an incomplete field that is required for 
the form. Check your forms to ensure all required fields are completed 
and then add the completed forms to the solicitation (or amendment) 
package and sign and submit your response.  
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NOTE: Ensure you have deleted all blank resource data entry 
forms from the package; otherwise, you will get error messages 
similar to this one for all of the required fields for every 
blank form that is still attached to the package.  

(5) You have not responded to the latest amendment package:  

 

You are not working with the most current amendment package that 
was posted to FBO. If a solicitation has been amended after you have 
downloaded the solicitation or another amendment package, but before 
you have submitted an offer, then you may get this error message. 
Access the FBO Web site and download the latest amendment package 
for the solicitation, attach your completed forms to the amendment 
package, and sign and submit your response. 

(6) All of the amendment files are not attached to the 
solicitation: 

 
If you get this message, you can close this window. Access the 
Attachments list and ensure you have not deleted any of the 
Amendment #.pff files from the amendment package. If the 
Amendment file is not in the package, then you may not be working with 
the most current amendment package that was posted to FBO. If a 
solicitation has been amended after you have downloaded the 
solicitation or amendment package, but before you have submitted an 
offer, then you may get this message. Check FBO to ensure you have 
the most current amendment package (refer to Section 5.1, 
“Downloading a Solicitation Package from FedBizOpps (FBO)”). 

IMPORTANT 

If you get an error message that you have questions about, 
make a note of the reference number (if there is one) and 
contact the Interagency Incident Systems Helpdesk at 
helpdesk@dms.nwcg.gov or (866) 224-7677. Press Option 3 for 
VIPR / eAuth. (You will need to provide the reference number to 
the Helpdesk.) 

mailto:helpdesk@dms.nwcg.gov
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This section describes the procedures for revising your offer for an open 
solicitation, responding to a request from the Contracting Officer for a revised 
offer for a closed solicitation, and withdrawing your offer on a solicitation. 

6.1 Submitting a Revised Offer on an Open Solicitation 

To update information or revise an offer you have already submitted, you will 
need to make any necessary changes to the forms, attach the updated forms to 
the solicitation (or amendment package if the solicitation has been amended), 
delete the old forms, and then re-submit your offer. 

Business Rules:  
You can update your company and resource information and re-submit a revised 
offer at any time until the solicitation close date. 

VIPR will use the Vendor’s last response as the response on record; VIPR will 
NOT try to determine the difference between multiple packages for the same 
solicitation sent by the same Vendor. 

 
To update your information and submit a revised offer on an open 
solicitation: 

1 From Windows Explorer, open the Solicitations folder. 

2 Double-click on your company form or the resource data entry form you wish 
to update.  

3 Make any necessary changes to the company information form and/or the 
resource forms.  

IMPORTANT 

You must ensure you complete all of the required fields, which are 
indicated by an asterisk and yellow background on the form. 

4 Once you have entered all of your data, click the Validate Form button (at 
the bottom of each form) to ensure you have completed all of the required 
fields and entered data correctly. 
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If you receive a validation error, please refer to the validation message 
and check the following: 

• All of the required fields have data entries. 

• The appropriate type of information is provided in the fields, e.g., 
the first Zip Code box has five (5) digits. 

• In some cases, if one field in a group of fields has a data entry, then 
the other fields in the group become required. For example, for the 
Contact Information, if a First Name is entered, then the Last Name, 
Daytime Phone, and E-mail Address fields are then required.  

If you have questions about the validation errors, contact the Interagency 
Incident Systems Helpdesk at helpdesk@dms.nwcg.gov or (866) 224-7677. 
Press Option 3 for VIPR. 

5 Once your updates are complete, click the Save button (located at the top in 
the Form toolbar and at the bottom of the form). 

6 Repeat Steps 2-5 for every form you wish to update.  

Once you have finished updating your forms, follow the steps listed below to 
open the solicitation package that you wish to re-submit with your updated 
information, delete your old forms from the package, and add your updated 
forms to the package. 

IMPORTANT 

You may want to check the FBO site to ensure you are working off of the 
latest version of the solicitation package; there may have been amendments 
posted to the solicitation since your last response was submitted. If you 
need to download a new amendment package, follow the steps described in 
Section 5.1, “Downloading a Solicitation from FedBizOpps (FBO),” otherwise, 
proceed to Step 7. 

7 From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

 

8 Double-click on the <solicitation number>.pff file or if the solicitation has 
an amendment, double-click on the <solicitation number_Amendment 
#>.pff file. The SF 1449 form appears. 
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9 From the Form menu, select Attachments. (You can also click on the paper 
clip icon to access the Attachments.) 

 

10 From the Attachments list, select the .pff file that you are going to replace, 
and then click the Delete button. Your old form is deleted from the 
package.  

 

11 From the Attachments list, click the Add button.  
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12 From the Solicitations folder, select your updated form, and then click the 
Open button.  

 

Your updated form is now attached to the solicitation package. 
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13 Repeat Steps 10-12 for every form that you wish to replace with an updated 
form.  

14 Click the Close button to close the Attachments list.  

15 Click the Save button to save your updated solicitation package to the SF 
1449 form. 

16 Once the updated information is attached to the SF 1449 form, go to Section 
5.3, “Signing and Submitting an Offer,” to sign and submit your offer. 

 

Business Rule: If the information you have updated applies to other 
solicitations you have responded to, then you must repeat this process for each 
solicitation you responded to.  

6.2 Submitting a Revised Offer After the Solicitation 
Has Closed  

Business Rule: After a solicitation is closed, you CANNOT update your 
information and submit a revised offer for that solicitation UNLESS the CO has 
notified you of a problem and allows you to re-submit your response or the CO 
has entered into negotiations with you and has requested a revised offer.   

In this case, you can update the information and submit a revised offer by 
following the procedures described in Section 6.1, “Submitting a Revised Offer 
on an Open Solicitation.” 
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6.3 Withdrawing an Offer 

Business Rules:   
You can withdraw your offer on a solicitation anytime before the solicitation 
closes.  

If you have submitted offers to other solicitations, those solicitation responses 
will NOT be affected by the withdrawal request for a specific solicitation. 

 
To withdraw an offer: 

Telephone or e-mail the CO that you wish to withdraw your offer.  The CO will 
ensure your solicitation response is withdrawn from the VIPR system. 

NOTE: The “Withdraw Offer” button on the SF 1449 form is intended for future 
functionality and is not currently enabled.  
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77  Responding  to  an  Amended  
Solicitation  
Responding to an Amended
Solicitation

The procedures for responding to an amended solicitation vary slightly 
depending on whether or not you have submitted a response to the solicitation 
before it was amended. Depending on your situation, do one of the following:  

• If you are going to submit an offer for the first time on an 
amended solicitation, follow the same procedures described in 
Section 5, “Responding to a Solicitation,” but download the amendment 
package from FBO. 

• If you have already submitted an offer on a solicitation and that 
solicitation has been amended since you submitted your offer, 
VIPR will send you an e-mail notice informing you of the amendment 
and providing a link to the amended solicitation package. You will need 
to follow the procedures described below. 

IMPORTANT 

If you submitted an offer on a solicitation and the solicitation has been 
amended, you MUST respond to the amendment for that same 
solicitation and re-submit your offer by the solicitation close date and 
time or your offer will not be evaluated.  

To respond to an amended solicitation: 

1 In the e-mail message you receive from VIPR, double-click on the 
amendment solicitation package. 
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Example of an E-mail Message for an Amended Solicitation  

 

2 Save the amendment package in the appropriate Solicitations | 
<solicitation number> folder. 

NOTE: Before working with the amendment package, you may 
want to save a copy of the amendment package and rename it 
as “Original-<solicitation number_Amendment 1>.pff.”  

Business Rule: When responding to an amendment, you can update any of 
your company information or information on specific resources, if needed, 
before you attach your forms to the amendment package. 

3 Open the amendment package and from the Form menu, select 
Attachments. 

 

A list of Attachments appears. 
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4 From the Attachments list, click the Add button.  

 

5 From the Solicitations folder, select your company form, and then click the 
Open button.  
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Your company form is now attached to the amendment package. 

 

6 From the Attachments list, select the VendorCompany.pff file, and then 
click the Delete button. The blank VendorCompany form is deleted from the 
package.  

 

7 From the Attachments list, click the Add button.  
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8 From the Solicitations folder, select your resource form, and then click the 
Open button.  

 

Your resource form is now attached to the amendment package. 
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9 Repeat Steps 7-8 for every resource data entry form you want to add to 
the package.  

NOTE: Be sure to attach the Representations-Certifications 
document and any other submittals required by the solicitation. 

10 From the Attachments list, select the <resource data entry form>.pff 
file, and then click the Delete button.  

 

The blank form is deleted from the package.  

11 Repeat Step 10 to delete all of the blank forms within the amendment 
package. 

 

12 Click the Close button to close the Attachments list.  

70 VIPR Vendor Solution User Guide   
 USDA Forest Service – Acquisition Management  



  Responding to an Amended Solicitation 
 

VIPR Vendor Solution User Guide  71 
USDA Forest Service – Acquisition Management  

13 Click the Save button to save the amendment package with your company 
and resource data entry forms attached. 

14 Once your forms are attached to the amendment package, go to Section 5.3, 
“Signing and Submitting an Offer,” to sign and submit your offer. 

 

Business Rule: When responding to an amended solicitation, you MUST submit 
a complete package, which means you MUST ATTACH ALL of the resource forms 
that you want to include with your offer and that still apply to the amended 
solicitation.  
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Once a CO is done awarding agreements for a solicitation, VIPR notifies Vendors 
whether or not they have received the award.  

If you are NOT AWARDED an agreement, VIPR will send you an e-mail 
informing you that you did not receive an award for a specific solicitation. If you 
have questions about the award decision, contact the CO. 

If you ARE AWARDED an agreement, VIPR will send you an e-mail informing 
you that you have received an award; the e-mail will include the complete 
agreement package. (Below is an example of an award e-mail message.) 

 

The agreement package includes the following: 

• SF 1449 (with your eSignature and the CO’s eSignature) 

• SF 30 (if there were any amendments during the solicitation process) 

• Schedule of Items 

• Table of Contents 

• Your completed company information form 

• Your completed data entry forms for each resource  

• All of the contract requirements 

Once you receive an award, you can do the following: 

• Print the Agreement 

• Replace equipment on an agreement 

• Withdraw equipment on an agreement 
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8.1 Printing an Agreement 

IMPORTANT 

When you receive notification of award of an agreement, you MUST print 
the agreement, and as required by the agreement, when dispatched, bring 
to the incident a minimum of two copies of the complete agreement for each 
resource. To print the complete agreement, you must print the following: 
(1) SF 1449, (2) SF 30 (if there are any), (3) Schedule of Items, (4) Table of 
Contents, (5) Contract Requirements and Exhibits, (6) Vendor Company 
Information form, and (7) Resource Data Entry form. The agreement 
accompanying the resource to the incident may include only the resource 
data entry form associated with that specific resource. 

For instructions on how to print the agreement and its attachments, refer to 
Section 10, “Printing Packages.” 

8.2 Replacing Equipment on an Agreement 

If you wish to replace equipment on an agreement, you can do so as long as the 
equipment is equal or better.  

To replace equipment on an agreement, you will need to telephone or e-mail the 
CO on the agreement and request a modification to the agreement. The CO will 
issue a modification and the modification package will be e-mailed to you. Once 
you receive the modification package, you will need to follow the procedures in 
Section 9, “Responding to a Modified Agreement.”  

Business Rules: If you replace equipment, it must be with equal or better 
equipment. VIPR will create a new DPL with the new equipment detail, but will 
NOT re-sort the order of the Vendors on the DPL. 

You cannot change the price or the Dispatch Center for the replacement 
equipment. 

8.3 Withdrawing Equipment on an Agreement 

If you wish to withdraw equipment on an agreement, you will need to telephone 
or e-mail the CO on the agreement and request a modification to the agreement. 
The CO will issue a modification and the modification package will be e-mailed to 
you. Once you receive the modification package, you will need to follow the 
procedures in Section 9, “Responding to a Modified Agreement.”  
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99  Responding  to  a    
Modified  Agreement  
Responding to a
Modified Agreement

After you accept an awarded agreement, if the agreement is modified by the CO, 
VIPR will send you an e-mail notice informing you of the modification and 
providing a link to the modification package. 

IMPORTANT 

You MUST respond to the modification.  

To respond to a modified agreement: 

1 In the e-mail message you receive from VIPR, double-click on the 
modification package. 

Example of an E-mail Message for a Modified Solicitation  

 

2 Save the modification package to the Solicitations | <solicitation 
number> folder. 

3 Open the package and from the Form menu, select Attachments. 
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A list of Attachments appears. 

 

4 From the Attachments list, double-click on the Modification#.pff file. The 
modification form (also known as the SF 30 form) appears.  
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5 In Box 14 on the form, view the Description of the 
Amendment/Modification. 

 

6 Close the SF 30 form and based on the type of modification, follow the 
appropriate procedures: 

For this type of 
modification 

 Do this… 

CO has modified the 
contract 
requirements 

a. From the Attachments list, double-click on the 
ContractRequirements.pdf file.  

b. View the contract requirements, and then close the 
document. 

c. Go to Step 3 in Section 5.3, “Signing and Submitting an 
Offer” to sign and submit your response to the 
modification. 

CO has modified 
their CO information 

No action is required, except to sign the response (go to 
Step 3 in Section 5.3, “Signing and Submitting an Offer” to 
sign and submit your response to the modification). 

Vendor needs to 
modify their Vendor 
company information

a. From the Attachments list, double-click on the 
VendorCompany.pff form or use your existing form.  

b. Make your updates to the form. 

c. From the File menu, select Save As and save the 
updated VendorCompany.pff form to your Solicitations 
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For this type of 
modification 

 Do this… 

folder, and then close the form. 

d. From the Attachments list, click the Add button and 
select your updated company form. 

e. From the Attachments list, select the old 
VendorCompany.pff form, and then click the Delete 
button.  

f. Go to Step 3 in Section 5.3, “Signing and Submitting an 
Offer” to sign and submit your response to the 
modification. 

Vendor needs to 
withdraw a resource 

NOTE: There is a “withdraw” function on each resource 
data entry form; however, each form may vary slightly.  

a. From the Attachments list, double-click on the 
<resource data entry form>.pff form.  

b. In the Agreement Phase Only box (at the top of the 
form), select the Withdraw this resource check box.  

c. From the drop-down list, select the VIN/Serial Number 
that you wish to withdraw. (Some forms will not have this 
drop-down list because certain types of resources cannot 
be individually withdrawn [e.g., tents]. You may need to 
contact the CO about canceling the agreement.) 

d. From the File menu, select Save As and save the 
updated <resource data entry form>.pff form to your 
Solicitations | solicitation number folder, and then 
close the form. 

e. From the Attachments list, click the Add button and 
select your updated <resource data entry form>.pff. 

f. From the Attachments list, select the blank <resource 
data entry form>, and then click the Delete button.  

g. Go to Step 3 in Section 5.3, “Signing and Submitting an 
Offer” to sign and submit your response to the 
modification. 

Vendor needs to 
replace a resource 

NOTE: Not all resource data entry forms will have the 
“replace” function.  

a. From the Attachments list, double-click on the 
<resource data entry form>.pff form.  

b. In the Agreement Phase Only box (at the top of the 
form), select the Replace this VIN/Serial Number 
check box.  

c. From the drop-down list, select the VIN/Serial Number 
that you wish to replace. (Some forms will not have this 
drop-down list because certain types of resources cannot 
be individually replaced [e.g., tents]. You may need to 
contact the CO about canceling the agreement.) 

d. Complete ALL of the required fields on the form with 
the new equipment information. 

NOTE: In order to successfully submit a response, you 
must select a Dispatch Center (DC) and enter data into the 
rate fields for the new resource data entry form since these 
fields are required; however, the data you enter into these 
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For this type of 
modification 

 Do this… 

fields will be ignored and will NOT replace the original DC 
and pricing information you submitted with your original 
offer.  

e. From the File menu, select Save As and save the 
updated <resource data entry form>.pff form to your 
Solicitations | solicitation number folder, and then 
close the form. 

f. From the Attachments list, click the Add button and 
select your updated <resource data entry form>.pff. 

g. From the Attachments list, select the blank <resource 
data entry form>, and then click the Delete button.  

h. Go to Step 3 in Section 5.3, “Signing and Submitting an 
Offer” to sign and submit your response to the 
modification. 

CO has terminated 
the agreement 

No action is required. 

Vendor needs to 
cancel the 
agreement 

Go to Step 3 in Section 5.3, “Signing and Submitting an 
Offer” to sign and submit your cancellation. 

Once you have completed the appropriate procedures for the specific type of 
modification, go to Step 3 in Section 5.3, “Signing and Submitting an Offer” 
to sign and submit your response to the modification.  
 

IMPORTANT 

When you receive notification of a modification to an agreement, you 
MUST print the modified agreement, and as required by the agreement, 
you MUST carry with you to the incident a minimum of two copies of the 
complete modified agreement for each resource. To print the complete 
agreement, you must print (1) SF 1449, (2) SF 30, (3) Schedule of 
Items, (4) Table of Contents, (5) Contract Requirements and Exhibits, 
(6) Vendor Company Information form, and (7) Resource Data Entry 
form. The agreement accompanying the resource to the incident may 
include only the resource data entry form associated with that specific 
resource. 
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At any point in the process, you can print the forms and other documents within 
a solicitation, amendment, agreement, or modification package. 

NOTE:  Since the forms are separate documents, you will need to print one 
document at a time. Also, the procedures listed below for printing the forms 
within a package are the same regardless of the type of package you are 
printing; the only difference will be the file you open in Step 2.  

IMPORTANT 

When you receive notification of award of an agreement, you MUST print 
the agreement, and as required by the agreement, you MUST carry with you 
to the incident a minimum of two copies of the complete agreement for each 
resource. To print the complete agreement, you must print (1) SF 1449, (2) 
SF 30 (if there are any), (3) Schedule of Items, (4) Table of Contents, (5) 
Contract Requirements and Exhibits, (6) Vendor Company Information form, 
and (7) Resource Data Entry form. The agreement accompanying the 
resource to the incident may include only the resource data entry form 
associated with that specific resource. 

To print the forms in a package: 

1 From Windows Explorer, open the Solicitations | <solicitation number> 
folder. 

 

2 Double-click on the <solicitation number>.pff form. The SF 1449 form 
opens.  
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3 From the File menu, select Print.  

 

The Print screen opens. 
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4 Select your print options, and then click the OK button. The form prints.  

5 On the SF 1449 form, from the Form menu, select Attachments. The list of 
the attachments associated with the solicitation opens.  

 

6 Double-click on the attachment you wish to print. The document opens. 

7 In the document, from the File menu, select Print. 
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The Print screen opens. 

 

8 Select your print options, and then click the OK button. The form prints. 

9 Close the form. The list of Attachments re-appears. 

10 Repeat Steps 6 - 9 for all of the attachments. 

11 Once all of the documents are printed, click the Close button on the 
Attachments box and close the SF 1449 form. 
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1111  Accessing  the  Dispatch  Priority  
Lists  (DPLs)  
Accessing the Dispatch Priority
Lists (DPLs)

You can access the Dispatch Priority List (DPL) from the Incident Procurement 
Web site at http://www.fs.fed.us/business/incident/vipr.php.

http://www.fs.fed.us/business/incident/vipr.php


Appendices  
 

84 VIPR Vendor Solution User Guide   
 USDA Forest Service – Acquisition Management  

1212  Appendices  Appendices

• Appendix A – Comprehensive List of the Business Rules 

• Appendix B – Key Links and Resources 

• Appendix C – Vendor’s Procurement Process Checklist 

• Appendix D – List of Host Dispatch Centers 
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12.1 Appendix A – Comprehensive List of Business Rules 

Below is a comprehensive list of all of the business rules highlighted 
throughout the user guide. 

Completing the Vendor Company Information 
• You MUST attach a completed Vendor Company Information form to 

EVERY offer you submit. 

Completing the Resource (Equipment/Crew) Information  
• You MUST always attach at least one completed resource data entry 

form for each piece of equipment to EVERY offer you submit. 

• You MUST attach one completed resource data entry form for every 
resource that will be in your solicitation response. For example, if your 
response will include two Engine Type 3s, then you will need to attach 
two Engine Type 3 forms; you CANNOT attach one form for both 
Engines. Another example is the Tent resource, where you must have 
one form for each Tent type. 

Signing and Submitting an Offer 
• You can continue to update your company and resource information and 

re-submit an offer (solicitation package) until the solicitation close date. 
After the close date, VIPR will not accept a response unless the CO has 
notified you of a problem and allows you to re-submit your response or 
has entered into negotiations and requested a revised offer. 

• VIPR will use the Vendor’s last response as the response on record; VIPR 
will NOT try to determine the difference between multiple packages for 
the same solicitation sent by the same Vendor. 

Submitting a Revised Offer on an Open Solicitation 
• You can update your company and resource information and re-submit a 

revised offer at any time until the solicitation close date. 

• VIPR will use the Vendor’s last response as the response on record; VIPR 
will NOT try to determine the difference between multiple packages for 
the same solicitation sent by the same Vendor. 

• If the information you have updated applies to other solicitations you 
have responded to, then you must repeat this process for those 
solicitation responses as well. 

Submitting a Revised Offer After the Solicitation Has Closed 
• After a solicitation is closed, you CANNOT update your information for 

that solicitation UNLESS the CO has notified you of a problem and allows 
you to re-submit your response or has entered into negotiations and 
requested a revised offer.  



Appendices  
 

86 VIPR Vendor Solution User Guide   
 USDA Forest Service – Acquisition Management  

Withdrawing an Offer 
• You can withdraw your offer on a solicitation UNTIL either the CO has 

indicated that the CO is done awarding for that solicitation or you are 
selected as a Vendor to receive an agreement for the solicitation.  

• If you have submitted offers to other solicitations, those solicitation 
responses will NOT be affected by the withdrawal request for a specific 
solicitation. 

Responding to an Amendment 
• When responding to an amendment, you can update any of your 

company information or information on specific resources, if needed, 
before you attach your forms to the amendment package. 

• When responding to an amended solicitation, you MUST submit a 
complete package, which means you MUST ATTACH ALL of the resource 
forms that you want to include with your offer and that still apply to the 
amended solicitation.  

Replacing Equipment on an Agreement 
• If you replace equipment, it must be with equal or better equipment. 

VIPR will create a new DPL with the new equipment detail, but will NOT 
re-sort the order of the Vendors on the DPL. 

• You cannot change the price or the Dispatch Center for the replacement 
equipment. 
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12.2 Appendix B – Key Links and Resources 

Below is a comprehensive list of all of the links and references other documents 
that are referred to in the user guide. 

• Incident Procurement Information for all Vendors 

- Forest Service Incident Procurement VIPR Web site. 
Provides incident procurement information and tools to current 
and potential Vendors. 
http://www.fs.fed.us/business/incident/vipr.php 

- Data Universal Number System (DUNS). Provides 
instructions for registering for a DUNS number, which is required 
by the Federal Acquisition Regulations (FAR 52.204-6) and you 
must have this before registering in the CCR. 
http://fedgov.dnb.com/webform/index.jsp 

- Central Contractor Registration (CCR). Provides instructions 
for registering with CCR. 
http://www.ccr.gov/Contractors.aspx   

- Online Representations and Certifications Application 
(ORCA). Provides instructions for registering online with ORCA. 
http://orca.bpn.gov 

• Information for VIPR Vendors 

- Frequently Asked Questions. Lists common questions and 
answers regarding all aspects of VIPR and the VIPR Vendor 
Solution. 
http://www.fs.fed.us/business/incident/faq.php 

- VIPR Vendor Solution Tutorials (Available in mid-January 
2009). Provides interactive online tutorials that walk Vendors 
step-by-step through the process for responding to solicitations, 
acknowledging amendments, receiving awarded agreements, 
and responding to any agreement modifications. 
http://www.fs.fed.us/business/incident/vendorsupport.php 

- USDA eAuthentication Level 2 Account. Provides 
instructions for how to obtain an eAuth Level 2 account.   
http://www.fs.fed.us/business/incident/eauth.php 

- VIPR Vendor Solution Quick Reference Guide. Provides 
high-level instructions for responding to solicitations, 
acknowledging amendments, receiving awarded agreements, 
and responding to any agreement modifications. (This is a 
scaled-down version of this VIPR Vendor Solution User Guide.)  
http://www.fs.fed.us/business/incident/vendorsupport.php 
 
 
 

http://www.fs.fed.us/business/incident/vipr.php
http://fedgov.dnb.com/webform/index.jsp
http://www.ccr.gov/Contractors.aspx
http://orca.bpn.gov/
http://www.fs.fed.us/business/incident/faq.php
http://www.fs.fed.us/business/incident/vendorsupport.php
http://www.fs.fed.us/business/incident/eauth.php
http://www.fs.fed.us/business/incident/vendorsupport.php
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• FedBizOpps (FBO)  

- FBO Web site. Provides list of VIPR I-BPA competitive 
solicitation opportunities.  
http://www.fbo.gov 

- FBO Vendor Guide. Provides details about how to use the 
features of the FBO Web site. 
https://www.fbo.gov/downloads/FBO_Vendor_Guide.pdf. 

• Interagency Incident Systems Helpdesk. Provides assistance to 
Vendors using the VIPR Vendor Solution. Contact information is 
helpdesk@dms.nwcg.gov or (866) 224-7677, press Option 3 for VIPR / 
eAuth. The Helpdesk is open between 12:00 p.m. and 8:00 p.m. Eastern 
Time (Monday – Saturday). 
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http://www.fbo.gov/
https://www.fbo.gov/downloads/FBO_Vendor_Guide.pdf
mailto:helpdesk@dms.nwcg.gov


  Appendices 
 

VIPR Vendor Solution User Guide  89 
USDA Forest Service – Acquisition Management  

12.3 Appendix C – Vendor’s Procurement Process 
Checklist 

Below is a high-level checklist to assist Vendors through the key stages of the procurement process. 
Detailed instructions for each task are located in the appropriate sections in the user guide.   

Done Task 

 Completed all tasks for Getting Started (Section 2) 

 Register for DUNS number. 

 Register for CCR. 

 Obtain e-mail address if you do not currently have one. 

 Obtain eAuthentication Level 2 account. 

 Install Formatta Filler® software on PC. 

 Have access to Internet Explorer® 6.0 or better and enable Java script.  

 Turn off Pop-up blocker in Internet Explorer® Tool | Options. 

 Gather company and resource information needed for responding to a solicitation. 

 Completed all tasks for Responding to a Solicitation (Section 5) 

 Download latest version of solicitation/amendment package from FBO and set up folder structure for managing packages. 

 Review contract requirements for solicitation. 

 Complete the Section E-3 contract requirements for the solicitation. 

 Complete Vendor Company Information form.  

 Complete resource data entry forms for each resource that you will include with your offer.  

 Add completed forms to SF 1449 form. 

 Remove blank forms from SF 1449 form. 

 Sign and submit offer. 

 Completed all tasks for Submitting a Revised Offer on an Open Solicitation, when applicable (Section 6) 

 Check the FBO Web site to ensure you are working with the latest version of the solicitation or amendment package. 

 Update your Vendor Company Information form, if applicable.  

 Update your resource data entry forms for each resource that you will include with your offer, if applicable.  

 Add completed forms to SF 1449 form. 

 Remove blank forms from SF 1449 form. 

 Sign and submit offer. 

 Completed all tasks for Responding to an Amended Solicitation, when applicable (Section 7) 

 Download latest version of solicitation/amendment package from FBO or access the package from the e-mail sent by VIPR. 

 Review contract requirements for amended solicitation. 

 Update (if you need to) your company information form.  

 Update (if you need to) the resource data entry forms for each resource that you will include with your offer.  

 Add completed forms to SF 1449 form. 
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Done Task 

 Remove blank forms and/or old forms from SF 1449 form. 

 Sign and submit offer. 

 Completed all tasks for Working with Agreements, when applicable (Section 8) 

 Access the package from the e-mail sent by VIPR. 

 Print all of the documents in the agreement. 

 Ensure you take two copies of the agreement with you to the incident. 

 Completed all tasks for Responding to a Modified Agreement, when applicable (Section 9)  

 Access the package from the e-mail sent by VIPR. 

 Follow the procedures for the specific type of modification. 

 Sign and submit response to modification. 

 Print all of the documents in the agreement. 

 Ensure you take two copies of the agreement with you to the incident. 
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12.4 Appendix D – List of Host Dispatch Centers 
The list of Dispatch Centers to be used for VIPR 1.0. 
 

 

Region 
Unit 
Identifier Center Name City  State 

NORTHERN ROCKIES 

1 ID-CDC Coeur dAlene Interagency Dispatch Center Coeur d'Alene ID 

1 ID-GVC Grangeville Interagency Dispatch Center Grangeville ID 

1 MT-BDC Billings Dispatch Center Billings MT 

1 MT-BRC Bitterroot Dispatch Center Hamilton MT 

1 MT-BZC Bozeman Interagency Dispatch Center Bozeman MT 

1 MT-DDC Dillon Dispatch Center Dillon MT 

1 MT-GDC Great Falls Dispatch Center Great Falls MT 

1 MT-HDC Helena Interagency Dispatch Center Helena MT 

1 MT-KDC Kootenai Interagency Dispatch Center Libby MT 

1 MT-KIC Kalispell Interagency Dispatch Center Kalispell MT 

1 MT-LEC Lewistown Interagency Dispatch Center Lewistown MT 

1 MT-MCC Miles City Dispatch Center Miles City MT 

1 MT-MDC Missoula Interagency Dispatch Center Missoula MT 

1 ND-NDC North Dakota Dispatch Center Bismarck ND 

ROCKY MOUNTAIN AREA  

2 CO-CRC Craig Interagency Dispatch Center Craig CO 

2 CO-DRC Durango Interagency Dispatch Center Durango CO 

2 CO-FTC Fort Collins Interagency Dispatch Center Fort Collins CO 

2 CO-GJC Grand Junction Air Center Grand Junction CO 

2 CO-MTC Montrose Interagency Dispatch Center Montrose CO 

2 CO-PBC Pueblo Interagency Dispatch Center Pueblo CO 

2 SD-GPC Great Plains Interagency Dispatch Center Rapid City SD 

2 WY-CDC Cody Interagency Dispatch Center Cody WY 

2 WY-CPC Casper Interagency Dispatch Center Casper WY 

2 WY-RWC Rawlins Interagency Dispatch Center Rawlins WY 

SOUTHWEST  

3 NM-SWC Southwest Coordination Center Albuquerque NM 

3 AZ-FDC Flagstaff Interagency Dispatch Center Flagstaff AZ 

3 AZ-PDC Prescott Interagency Dispatch Center Prescott AZ 

3 AZ-PHC Phoenix Interagency Dispatch Center Phoenix AZ 

3 AZ-SDC 

 

Show Low Interagency Dispatch Center 

(Formerly Springerville Interagency Dispatch Center 

Show Low 

(Springerville) 

AZ 

(AZ) 
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 Unit 
Region Identifier Center Name City  State 

3 AZ-TDC Tucson Interagency Dispatch Center Tucson AZ 

3 AZ-WDC Williams Interagency Dispatch Center Williams AZ 

3 NM-ABC Albuquerque Interagency Dispatch Center Albuquerque NM 

3 NM-ADC Alamogordo Interagency Dispatch Center Alamogordo NM 

3 NM-SDC Silver City Interagency Dispatch Center Silver City NM 

3 NM-SFC Santa Fe Interagency Dispatch Center Santa Fe NM 

3 NM-TDC Taos Interagency Dispatch Center Taos NM 

EASTERN GREAT BASIN 

4 ID-BDC Boise Interagency Logistics Center Boise ID 

4 ID-CIC Central Idaho Interagency Fire Center Salmon ID 

4 ID-EIC Eastern Idaho Interagency Fire Center Idaho Falls ID 

4 ID-PAC Payette National Forest Dispatch McCall ID 

4 ID-SCC South Central Idaho Dispatch Center Shoshone ID 

4 UT-CDC Color Country Interagency Fire Center Cedar City UT 

4 UT-MFC Moab Interagency Fire Center Moab UT 

4 UT-NUC Northern Utah Interagency Fire Center Salt Lake City UT 

4 UT-RFC Richfield Interagency Fire Center Richfield UT 

4 UT-UBC Uintah Basin Interagency Fire Center Vernal UT 

4 WY-TDC Teton Interagency Dispatch Center Moose WY 

WESTERN GREAT BASIN 

4 NV-CNC Central Nevada Interagency Dispatch Center Winnemucca NV 

4 NV-ECC Ely Interagency Communication Center Ely NV 

4 NV-EIC Elko Interagency Dispatch Center Elko NV 

4 NV-LIC Las Vegas Interagency Communications Center Las Vegas NV 

4 NV-SFC Sierra Front Interagency Dispatch Center Minden NV 

NORTHERN CALIFORNIA OPERATIONS  

5 CA-CICC Camino Interagency ECC Camino CA 

5 CA-FICC Fortuna Interagency ECC Fortuna CA 

5 CA-GVCC Grass Valley Interagency ECC Grass Valley CA 

5 CA-MICC Modoc Interagency ECC Alturas CA 

5 CA-MNFC Mendocino National Forest Communication Center Willows CA 

5 CA-PNFC Plumas National Forest Communication Center Quincy CA 

5 CA-RICC Redding Interagency ECC Redding CA 

5 CA-SIFC Susanville Interagency ECC Susanville CA 

5 CA-YICC Yreka Interagency ECC Yreka CA 

SOUTHERN CALIFORNIA OPERATIONS 

5 CA-ANCC Angeles Communications Center Arcadia CA 
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Region 
Unit 
Identifier Center Name City  State 

5 CA-CCCC Central California Communications Center Porterville CA 

5 CA-LPCC Los Padres Communications Center Santa Maria CA 

5 CA-MVIC Monte Vista Interagency Command Center El Cajon CA 

5 CA-OVCC Owens Valley Interagency Communications Center Bishop CA 

5 CA-SBCC San Bernardino Interagency Communications Center San Bernardino CA 

5 CA-SICC Sierra Interagency Communications Center Fresno CA 

5 CA-STCC Stanislaus Communications Center Sonora CA 

NORTHWEST 

6 OR-BIC Burns Interagency Communications Center Burns OR 

6 OR-COC Central Oregon Interagency Dispatch Center Prineville OR 

6 OR-EIC Eugene Interagency Communication Center Eugene OR 

 

 

OR-GPC - Grants Pass Interagency Fire Center 

(Combined with OR-MIC) Grants Pass OR 

6 OR-JDCC John Day Communications Center John Day OR 

6 OR-KFC Klamath Falls Interagency Fire Center Klamath Falls OR 

6 OR-LFC Lakeview Interagency Fire Center Lakeview OR 

6 OR-MIC Medford Interagency Communication Center Medford OR 

6 OR-NOC Northeast Oregon Interagency Fire Center LaGrande OR 

 

 

OR-PIC - Pendleton Interagency Communication 
Center 

(Combined with OR-NOC) Pendleton OR 

6 OR-SFC Siuslaw National Forest Dispatch Corvallis OR 

6 OR-UPC Umpqua National Forest Dispatch Roseburg OR 

6 OR-VAC Vale District Dispatch Vale OR 

 

 

6 WA-CCC 

Columbia Cascade Communication Center 

(formerly Mt. Hood NF Dispatch OR-MHC) 

(formerly Gifford Pinchot NF Dispatch WA-GFC) 

Sandy 

Sandy 

Vancouver 

OR 

OR 

WA 

6 WA-CWC Central WA Interagency Communication Center East Wenatchee WA 

 

6 
WA-NEC 

Northeast Washington Interagency Communication 
Center 

(formerly Colville National Forest Dispatch WA-CFC) Colville WA 

6 WA-PSC Puget Sound Interagency Coordination Center Everett WA 

SOUTHERN AREA 

8 AL-AIC Alabama Interagency Coordination Center Montgomery AL 

8 AR-AOC Arkansas-Oklahoma Interagency Coordination Center Hot Springs AR 

8 FL-FIC Florida Interagency Coordination Center Tallahassee FL 

8 GA-GIC Georgia Interagency Coordination Center Gainesville GA 

8 KY-KIC Kentucky Interagency Coordination Center Winchester KY 

8 LA-LIC Louisiana Interagency Coordination Center Pineville LA 

8 MS-MIC Mississippi Interagency Coordination Center Jackson MS 
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Region 
Unit 
Identifier Center Name City  State 

8 NC-NCC North Carolina Interagency Coordination Center Asheville NC 

8 SC-SCC South Carolina Interagency Coordination Center New Ellenton SC 

8 TN-TNC Tennessee Interagency Coordination Center Cleveland TN 

8 TX-TIC Texas Interagency Coordination Center Lufkin TX 

8 VA-RCC Roanoke Coordination Center Roanoke VA 

8 VA-VIC Virginia Interagency Coordination Center Charlottesville VA 

EASTERN AREA 

9 IL-ILC Illinois Interagency Dispatch Center Murphysboro IL 

9 IN-IIC Indiana Interagency Coordination Center Tell City IN 

9 ME-NEC Northeastern Interagency Coordination Center Augusta ME 

9 MI-HMFC Huron-Manistee Dispatch Center Cadillac MI 

9 MI-UPC Upper Peninsula Interagency Dispatch Center Escanaba MI 

9 MN-MFC Minnesota Interagency Fire Center Grand Rapids MN 

9 MO-MOC Missouri Iowa Interagency Coordination Center Rolla MO 

9 OH-OIC Ohio Interagency Dispatch Center Nelsonville OH 

9 PA-ALFC Allegheny  Dispatch Center Warren PA 

9 WI-WIC Wisconsin Interagency Coordination Center Woodruff WI 

9 WV-MOFC Monongahela Dispatch Center Elkins WV 
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1313  Glossary  Glossary
Agreement Package 

 
 

Amendment 

Award 

CO 

Contract Requirements 

 
DPL 

 
FBO 

Formatta 

I-BPA 

 
Interagency Incident 

Systems Helpdesk 

Modification 

 
PFF 

Resource Category 

Solicitation Package 

 
 

Synopsis 

 
Vendor 

 
VIPR 

 
 
 

VIPR Vendor Solution 

 The documents that make up a complete awarded agreement including the SF-
1449, the contract requirements, the schedule of items, the vendor company form, 
and all applicable resource data entry forms.  

Changes to a published solicitation.  

Offer accepted by CO.  

Contracting Officer. 

The paragraphs included in the contract. Contract requirements include clauses, 
provisions, and the specifications included in Sections B, C, D, and E. 

Dispatch Priority List. The DPL is the list of Vendors that dispatchers will use to fill 
orders for equipment on an incident.  

FedBizOpps. 

Forms tool used for the VIPR Vendor Solution. 

Incident Blanket Purchase Agreement. The document resulting from the award of 
a pre-season agreement, using the SF-1449. 

Helpdesk supporting VIPR. 

 
A change to an awarded agreement; multiple modifications can be associated with 
an award. 

Formatta forms file type. 

A class of equipment. Example: Dozer, Engine, GIS Unit. 

The documents that are processed during the solicitation stage including the SF-
1449 top sheet, the contract requirements, and the Vendor’s response including 
the company information and resource forms.   

The notice published to FedBizOpps, notifying vendors that a solicitation will be 
issued with a summary of the requirements. 

Third-party company offering equipment and services to the Forest Service. Also 
known as Contractor. 

Virtual Incident Procurement; a Web-based incident procurement system that will 
replace and expand the Equipment and Training Inventory (EaTIS) prototype. COs 
will use VIPR to create and manage solicitations and agreements through the 
entire procurement process. 

A forms-based tool that Vendors use to respond to solicitations, acknowledge 
amendments, receive awarded agreements, and respond to any agreement 
modifications. 
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